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CBA HR

Introduction
 
Thank you for choosing the West Mountain Radio Computerized Battery Analyzer (CBA). The CBA is a powerful 
test instrument that measures, graphs, and compares performance of both primary and secondary (rechargeable) 
batteries and individual cells.  The CBA allows for the precise measurement of battery capacity and takes the 
guesswork out of choosing the best battery for your application.
 
The CBA is much more than a simple battery voltage tester or a battery load tester. It will test virtually any type 
or size of battery, any chemistry or number of cells, up to 55 volts. Now anyone can do scientific battery tests for 
a reasonable price.
 
The CBA alone is capable of tests up to a maximum of either 40 amps or 150 watts for short periods of time. 
For continuous operation, suggested values are 20 amps or 100 watts, whichever is higher.  When used with an 
optional amplifier, tests can be done at 500 watts. 
 
The CBA not only tests the total amount of energy stored in a battery (capacity in amp-hours), but also graphically 
displays and charts the voltage versus time using a constant current load. Graphs may be displayed, saved 
and printed, and the axis parameters can be changed at anytime.  Multiple test graphs of the same battery, or 
multiple batteries, may be compared or overlaid; a very useful feature. Battery test data may be printed in color 
or black and white to paper or convenient test labels to put directly on the tested batteries. An optional external 
temperature probe provides automatic over temperature test cutoff.
 
The CBA is ruggedly built and supplied with 12 gauge wire and Powerpole® connectors for battery test 
connections.  It is small with a high performance cooling system and quiet fan. LED indicators are visible from 
across a room that display communication and test status.
 
Standard software supplied with the CBA is easy to use, intuitive, and designed to protect both the CBA and 
batteries being tested.  It provides automatic sensing of battery cell count, a safety check of the test rate, and 
recommends a minimum safe discharge voltage. There are user editable and recallable battery test profiles and 
Capacity Discharge tests may be viewed in Amp Hours, Watt Hours or Minutes. The Charge Monitor Test mode 
charts and records voltage rise during a charge or discharge. Lab calibration current adjustment is a standard 
user feature to improve accuracy for testing at very low discharge rates, or for critical applications.
 
The optional Extended Software license provides all the features of the standard version, but adds five additional 
test modes: Time Discharge, Duty Cycle, Constant Power, Multiple Discharge and Constant Resistance. Results 
can be graphed as Voltage vs. Amp hours, Watt hours, Minutes or Ragone depending on the type of test.  Ragone 
graphs require the weight of the battery/batteries to be accurate. 
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Powerpole® is a registered trademark of Anderson Power Products

A CBA IV enables another test: Power Profile.  This test is very useful for power supply testing or solar cell 
analysis.  The resulting graph displays Voltage vs. Amps or Watts. The Extended Software version also adds 
the ability to graph battery temperature with CBA III and CBA IV (when the optional temperature probe is 
connected). An additional lab calibration feature makes it possible to compensate for test lead resistance, 
giving accurate readings at the battery terminals.
 
When using a CBA III with a 500W Amplifier, Extended Software is required.
When using a CBA IV with a 500W Amplifier, Standard or Extended Software will  provide provisions for 
operation with amplifiers for testing at high discharge rates or doing destructive testing.
 
CBA HR
Specifically designed to test and evaluate small cells and batteries – those capable of supplying quite low 
discharge currents.  Such small cells must be evaluated using even greater measurement precision than what 
is capable with CBA IV model.  Designed to precisely test virtually any small size battery, any chemistry or 
number of cells, from 0.7 to 10 volts. The CBA HR is capable of testing batteries at load currents from 1 mA to 
1000 mA, (10 watt maximum), in increments of 1 mA.  
 
An optional 4-wire test harness improves voltage measurement accuracy by minimizing the voltage sensing 
lead wire resistance effect.  Some optional harnesses also include an external magnetic probe, which when 
used with optional Extended Software allow logging of battery / ambient temperature and automatic over-
temperature test cutoff.
 
Standard Software is supplied with the CBA HR.  In addition to the four basic test modes included with the 
CBA IV (Mission Profile, Discharge, Charge Monitor, and Power Profile), the CBA HR adds two additional test 
modes (Duty Cycle and Multiple Discharge) to allow user simulation of real world battery load variations found 
in typical remote sensor sleep / transmit applications.  
 
The optional Extended Software license provides the ability to graph battery temperature when the optional 
magnetic temperature probe is connected. This optional temperature probe is included in selected test harness 
assemblies and is connected to the CBA HR via a 3.5mm accessory input. 
 
The CBA HR is not designed to be used with optional West Mountain Radio 500 watt CBA Amplifiers.  For 
higher test currents and voltages that exceed the CBA HR’s ratings - use the West Mountain Radior CBA IV, 
which can accommodate one or more 500W Amplifiers.
  CBA IV Specifications
 
Electrical

•	 Maximum continuous discharge rate: 100 watts
•	 Maximum limited term discharge rate with < 3500 ma-hour battery: 125 watts
•	 Maximum limited term discharge rate with < 1000 ma-hour battery: 150 watts
•	 0-3 amp accuracy: typically better than + - 10 mA
•	 3-40 amp accuracy: typically better than + - 45 mA
•	 0-5 volt accuracy: typically better than + - .005 volts
•	 5-15 volt accuracy: typically better than + - .01 volts
•	 10-60 volt accuracy: typically better than + - .05 volts
•	 Maximum operating voltage: 55 Volts (48 Volt Lead Acid Telecom supported)
•	 Maximum discharge rate: 40 Amps (Battery dependent, 100 watt continuous)
•	 Minimum discharge voltage to maintain 30 Amps 0.9 Volts (Battery dependent)
•	 Minimum Voltage for a 40 Amp discharge: 2 Volts at completion of test (Battery dependent)
•	 Minimum discharge rate: 0.01 Amps (10 mA)
•	 Residual current drain, battery connected while not in use: < 3 mA @ 12 volts
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Hardware / Software
•	 High performance micro controller with USB interface and 12 bit A/D conversion
•	 USB powered: CBA does not use battery being tested to run the CBA or fan
•	 Computer Interface:  USB Type A to B (Cable Included)
•	 Load Connections (Battery Test):  Powerpole (+) / (-)
•	 I/O Port:  5 pin flat header for Temp Input & Serial Port
•	 LED indicators: System ready and Test in progress, viewable from across a room
•	 Internal over temperature sensing and protection
•	 Internal user replaceable fuse:  ATO / ATC 25 Amp ; ships with spare 40 Amp
•	 Graph printing on any standard color or B&W printer
•	 Battery test label printing on standard 5110

 
CBA HR (High Resolution) Specifications
 
Electrical

•	 Maximum continuous discharge rate: 10 watts
•	 Maximum discharge current:  1000 mA  (1.0 Amp)
•	 Minimum discharge current:  1.0 mA  (0.001 Amp)
•	 Discharge Current Accuracy:  better than +/- 20 uA @ 1 mA discharge
•	 Maximum operating test voltage:  10 volts
•	 Minimum operating test voltage:  0.7 volts
•	 Voltage reading accuracy:  better than +/- 0.01 volts
•	 Residual current drain, battery connected while not in use: < 200 uA @ 9 volts

 
Hardware / Software

•	 High performance micro controller with USB interface and 12 bit A/D conversion
•	 USB powered: CBA does not use battery being tested to run the CBA or fan
•	 Computer Interface:  USB Type A to B (Cable Included)
•	 Load Connections (Battery Test):  Powerpole (+) / (-)
•	 I/O Port:  3.5 mm for Temp Input & Remote Voltage sensing (4-wire) – when using temperature input, remote 

voltage sensing harness must also be used
•	 LED indicators: System ready and Test in progress, viewable from across a room
•	 Internal over temperature sensing and protection
•	 Internal user replaceable fuse:  ATO / ATC 2 Amp
•	 Graph printing on any standard color or B&W printer
•	 Battery test label printing on standard 5160 / 8160 stick-on labels
•	 Dimensions: 1.5” H x 2.8” W x 3.6” D
•	 Weight: 4 oz.
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 Safety Precautions
 
The West Mountain Radio CBA family of battery testers are inherently safe, but the batteries being tested are 
not. Any system that stores energy is potentially dangerous.  Some types of batteries are safer than others, but 
all are capable of causing explosions or fires.
 
For technical information on a specific battery, refer to the Battery Manufacturers website.  Most battery 
labels have limited information, but the manufacturer’s website usually includes more detailed technical 
information.  General information for batteries is also available on the West Mountain Radio CD.  Select Battery 
Information and FAQs.
 
Primary Safety Considerations:
 

•	 Never discharge a battery at a higher discharge rate than it was designed for.
•	 Never use a battery that has poorly insulated, frayed wiring, or exposed metal parts.
•	 Never connect a battery with reverse polarity.
•	 Never test a battery near flammable materials.
•	 Never allow a battery to reach a temperature that is too hot to touch.
•	 Recharge batteries immediately with an appropriate battery charger after the test is completed. Some 

types do not like to remain discharged for extended periods of time.
•	 Never test or charge batteries while unattended.
•	 Always have a fire extinguisher nearby.

 
CBA Operating Requirements:
 

•	 Never connect a battery with the polarity reversed.
•	 Always connect the USB cable to the CBA BEFORE connecting the battery.
•	 Be aware the heatsink of the CBA is at battery potential (positive terminal of battery).
•	 Never connect a battery to the CBA if that battery is connected to something else.
•	 Contact West Mountain Radio for support before connecting to a USB hub.
•	 Operate the CBA in a cool dry location.
•	 Never allow metal parts or wiring of the battery to come in contact with the metal heat sink of the CBA.
•	 Never allow the cooling fan to be blocked or jammed.
•	 Do not ignore the warnings from the CBA Software.
•	 The CBA can get hot. Do not touch the metal heat sink while, or shortly after, conducting a high power 

test.
 
Lead Acid Battery Safety Warnings:
 
Adhere to all safety considerations with lead acid batteries, especially while charging.  These batteries, especially 
automotive and marine types, give off explosive hydrogen gas when charged.  A nearby or internal spark or 
flame can cause a lead acid battery to explode sending liquid acid and lead shrapnel in all directions.  This is 
particularly dangerous and frequently causes blindness or severe scarring injuries.
Never use a standard lead acid battery without proper ventilation.  Sealed lead acid batteries such as gelled or 
AGM (absorbed glass mat) types are much safer.  Automotive and marine types are not as safe and should be 
used in protective ventilated housings.
 
Never make the last connection to a lead acid battery that may cause a spark on the terminal.  Always connect 
the load or charger last, and at a safe distance away from the battery.
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NiCad, NiMh, and Alkaline Safety Warnings:
 
Adhere to all safety considerations, as these types of batteries can also be dangerous.  If they are shorted 
out or charged/discharged at too high a rate, they can overheat and explode.  A single D size NiCad cell can 
actually melt a 10 penny (9 gauge) nail (it is not recommended to attempt.)
  
Lithium Safety Warnings:
Reprinted with permission of the Academy of Model Aeronautics
Words in bold and ( ) were added by West Mountain Radio
 
Lithium Battery Fires
Lithium batteries are becoming very popular for powering the control and power systems in our models. This 
is true because of their very high energy density (amp-hrs/wt. ratio) compared to NiCads or other batteries. 
With high energy comes increased risk in their use. The, principal, risk is FIRE which can result from improper 
charging, crash damage, or shorting the batteries. All vendors of these batteries warn their customers of this 
danger and recommend extreme caution in their use. In spite of this many fires have occurred as a result of 
the use of Lithium Polymer batteries, resulting in loss of models, automobiles, and other property. Homes and 
garages and workshops have also burned. A lithium battery fire is very hot (several thousand degrees) and is 
an excellent initiator for ancillary (resulting) fires. Fire occurs due to contact between Lithium and oxygen in the 
air. It does not need any other source of ignition, or fuel to start, and burns almost explosively.
 
These batteries must be used in a manner that precludes ancillary fire. The following is recommended:
 

1. Store, and charge (discharge), in a fireproof container; never in your model.
2. Charge (discharge), in a protected area devoid of combustibles. Always stand watch over the charging 

(discharging), process. Never leave the charging process unattended.
3. In the event of damage from crashes, etc, carefully remove to a safe place for at least a half hour to 

observe. Physically damaged cells could erupt into flame, and, after sufficient time to ensure safety, 
should be discarded in accordance with the instructions which came with the batteries. Never attempt 
to charge (discharge) a cell with physical damage, regardless of how slight.

4. Always use chargers designed for the specific purpose, preferably having a fixed setting for your 
particular pack. Many fires occur in using selectable/adjustable chargers improperly set. Never attempt 
to charge Lithium cells with a charger which is not specifically designed for charging Lithium cells. 
Never use chargers designed for Nickel Cadmium batteries.

5. Use charging systems that monitor and control the charge state of each cell in the pack. Unbalanced 
cells can lead to disaster if it permits overcharge of a single cell in the pack. If the batteries show any 
sign of swelling, discontinue charging, and remove them to a safe place outside as they could erupt into 
flames.

6. Most important: NEVER PLUG IN A BATTERY AND LEAVE IT TO CHARGE (DISCHARGE), 
UNATTENDED OVERNIGHT. Serious fires have resulted from this practice.

7. Do not attempt to make your own battery packs from individual cells.  These batteries CANNOT be 
handled and charged casually such as has been the practice for years with other types of batteries. The 
consequence of this practice can be very serious resulting in major property damage and/ or personal 
harm.
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Primary Safety Considerations:
 

•	 Never discharge a battery at a higher discharge rate than it is designed for.
•	 Never use a battery that has poorly insulated or frayed wiring or exposed metal parts.
•	 Never connect a battery with reverse polarity.
•	 Be aware the heatsink of the CBA is at battery potential (positive terminal of battery).
•	 Never test a battery near flammable materials.
•	 Never allow a battery reach a temperature that causes it to get so hot that it may be too hot to touch.
•	 Recharge batteries immediately with an appropriate battery charger after tests are completed. Some 

types do not like to remain discharged for extended periods of time.
•	 Never test or charge batteries while unattended.
•	 Always have a fire extinguisher nearby.

 
Liability Disclaimer
West Mountain Radio will not be liable to you (whether under the law of contract, the law of torts or otherwise) 
in relation to the contents of, or use of, or otherwise in connection with, the CBA (“product”):

•	 To the extent that the product may cause any bodily or equipment damage;
•	 For any indirect, special or consequential loss of any kind;
•	 For any business losses, loss of revenue, income, profits or anticipated savings, loss of contracts or 

business relationships, loss of reputation or goodwill, or loss or corruption of information or data.
 
By using this product, you agree to the limitations of liability set forth in this disclaimer are reasonable.
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Getting Started
 
It is recommended to read this entire manual and help files for a full understanding of the CBA and software 
operation.
 

1. From the CD ROM opening screen, click on “Software and Hardware Installation”.  Follow the instructions 
on the screen to complete both the hardware and software installations.

2. Connect the CBA to the PC’s USB port using the supplied cable before connecting a battery. 
 
NOTE: If the Windows message “Found new Hardware” appears, the previous step was not completed.

3. Start the West Mountain Radio CBA program. 
 
NOTE: For a CBA III the green LED will come on when the program starts. For CBA IVHR the LED will light as 
soon as the drivers are installed.  The software should start with a “New Test” screen in the “Auto-Check” profile.

 
4. In the “New test” window select the “Battery Type” (chemistry) and select or type in the “Capacity Ah”. 

 

NOTE: To convert mAh (milliampere hours) to Ah (Ampere hours) divide by 1000. If the capacity rating is not 
printed on the battery contact the manufacturer or visit their web page.

5. Connect the battery with very short, solid, low resistance connections using the proper connectors and polarity.   
 
WARNING: Be certain that you have the polarity correct.  For Standard convention: RED to RED, 
BLACK to BLACK, and PLUS to PLUS, MINUS to MINUS.

6. The battery voltage will display the resting fully charged battery voltage on the right side of the screen. Click 
the ‘Detect’ button for the software to suggest some baseline settings after selecting the chemistry type. 
 
If the number of cells or average pack voltage is not correct, check that the proper battery type was 
entered.  If sure the average pack voltage or cell count is incorrect, change the software estimate to the 
correct value in either the “Voltage” or “Cells”.

7. The discharge current in the “Test Amps” can also be suggested by the software by clicking ‘Suggest’. 
This calculation is based on the battery capacity and chemistry type.  If preferred to run a test at 
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different discharge rate, change the “Test Amps” window.    
 
WARNING: Do not choose a higher discharge rate than the battery is capable of.  See the the 
battery manufacturer’s specifications. 
 
NOTE: If the no load battery “Voltage” multiplied times the “Test Amps” selected (Volts x Amps = Watts) exceeds 
the wattage rating of the CBA, or the default recommended maximum discharge rate for a given battery type, 
the software will prompt to lower the discharge current before starting a test.  The CBA will run tests at up to 150 
watts, for short periods of time, with a battery that has a rated capacity of 1 Amp-Hr or less, up to 125 watts below 
3.5 Amp-Hrs and 100 watts for any capacity battery.  The CBA HR will run tests up to 10 watts, with maximum 
voltage of 10 volts and maximum current of 1 Amp.

8. Type in a “Test Name” for the test that positively identifies the test for future reference, perhaps write a 
number on the battery and use that number, or a unique description of the battery and the test.

9. Press the “Start” button in the “New Test” window. Optionally press “OK” and use the    button or 
selecting “Test --> Start” 
 
If the settings are correct notice the graph will appear and auto-scale.  The red LED on the CBA will 
come on and the fan will start. The virtual LED and fan on the right panel will start also.  The “Current” 
will ramp up to the “Test Rate” value and the voltage will start to record on the graph.   

10. The test will continue until the test “Cutoff V” is reached.  At that point the test will automatically 
stop and the program will beep and display “Test Complete”.  Everything will return to the 
stopped condition ready for another test or to save the file. Disconnect the battery at this time.   
 
WARNING: Do not ever leave a battery connected after a test completes!  Leaving a battery in 

a discharged state for prolonged period of time could over discharge and damage the battery.  
 
CAUTION: The battery and the CBA may be HOT

11. When the test is complete go to the “File” menu and save the file if desired.   
 
NOTE: The file name will default to the test name but it may be changed to another name if desired.  If the 
program is closed or another test is run, a prompt will ask if wanting to save the completed test already on the 
screen.  One filename can contain multiple test names.

12. To start another test, start at step 4 of these instructions.  Click the  button or “Test--> New.” .  When 
starting the new test, a prompt will ask if desire to save the previous test and start a new test or add that 
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test to the graph on the screen.
 
After running a discharge test on a rechargeable battery, the battery should be recharged. Most batteries are 
rated for many recharge cycles depending on the battery type and on the discharge rates, sometimes 1000’s 
of cycles.  Most batteries should not be left at their fully discharged cutoff voltages but should be stored in a 
partially charged state for maximum battery life.  Discharged batteries should also be promptly disconnected 
from the CBA to prevent its small parasitic draw from further reducing the battery voltage, which in some cases 
could eventually decrease voltage to a point that might compromise battery life.
 

Program Features
 
The installation and basic operation is covered in the Getting Started section of this manual and Help file. This 
section gives a detailed explanation of using the program and its features.
 

 
 

File Menu
 

New:
Starts a new test document. This will initialize a new blank graph.
 
Overlay:
Allows for opening a saved test document and to overlay the tests in that file over the test graph or graphs 
already on the screen as long as they are the same type. Once there is a series of graphs for battery comparison 
on the screen, these may be saved under an existing or new file name.
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NOTE: If there are test graphs on the screen no longer wanted, right click on the graph trace and select “Delete test” to 
remove that graph trace.
 
When selecting properties, it is possible to change the graph style, but only if the test was done and saved on 
Version 2 or later of the software.
 

Open:
Opena any saved file.  Old test files from the previous version 1 of CBA software may be opened by changing 
“Files of type” from .bt2 to .bt1.  When opening and displaying an old style .bt1 file, at the time of saving, it will 
be converted to the new .bt2 and saved in the new format.
 
Close:
Will close the file displayed on the screen and prompt to save it.
 

Save:
Saves the test document graph currently displayed on the screen.
 
Save As:
Saves a test under a new file name as a copy or to save the same file in a different folder location.
 
Export:
Converts the test file to .CSV (Comma Separated Values) comma separated file format and allows it to be 
saved for data manipulation with a spreadsheet program such as Excel®, or  a text viewer.
 

Print, Print Preview and Print Labels:
For a discussion of printing functions refer to the help section on printing.
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Recent Files:  
A convenient way to open files that were recently used from a list of the last eight files.
 
Exit:
Closes the program and will prompt to save a file of the tests on the screen.
 
Test Menu
 

New Test:
Opens a “New Test” window. This new test can be appended to the currently open graph or file.
 

Start, Stop, Properties:
These will be grayed out unless a “New Test” window was created and selected “OK” instead of “Start”.  If 
available, then start a test or stop a test in progress.  Properties will allow you to change the test name before 
starting a test or graph type at any time.
 
Chart Properties:
Allows for change to the graph scaling or put a title on the graph
Tip: It is recommended not to change the graph scaling as the automatic scaling works very well.
 
 
Tools menu
 
Preferences:
Ability to customize certain settings for the program such as “Temperature Units” (degrees C or F), Charting 
Options, and End of Test alerts
 

 
“Save window size and position” causes the program to come back with the same window the next time you 
open it.
 
“Open last file(s) on startup” causes the program to reopen the displayed test data next time the program is 
stated.
 
“Stop test when battery temperature reaches” “xx degrees” - allows for test termination when a battery exceeds 
the set point temperature – requires optional magnetic Temperature Probe to be attached to battery being tested.
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“Print charts in black-and-white” is for setting display to code the test line graphs for identity when not color 
coded.
 
“Anti-Alias chart text” smoothens the text graphics.
 
“Anti-Alias chart graphics” smoothens the graph graphics.
 
Audio tone and Repeat tone allow for audio notification when a test has ended. 
 
Lab Calibrate:
“Tools”, “Lab Calibrate”, depending on the software license (Standard or Extended) and hardware versions, 
provides options for calibration of Temperature, Discharge Current, and test lead Voltage drop. These are 
advanced options and should only be used by technically competent users having access to laboratory calibration 
standards.
 

 
Temperature Calibrate: 
The optional temperature probe may be calibrated at room temperature by comparing it to a room temp 
thermometer.  For highest accuracy place a lab grade thermometer and the CBA temperature probe in water 
heated to the temperature of interest for testing.  Calibration consists of setting the software value to read the 
exact temperature show on the lab-grade thermometer.  Enter this value in either degrees C or F window.
 
In the standard version of the software the temperature is displayed and the temperature may be used as a 
safety feature to automatically stop a test at a user set maximum battery temperature.
 
 
Current Calibrate:
An advanced option that only functions below 3 Amps. If there is a need for the most precise measurements and 
access to a lab quality ammeter that has known NIST traceable calibration, this option is available. This option 
allows a calibration offset to center the CBA’s calibration within a 12 bit window. In other words, it is possible to 
adjust the discharge current in 1 mA increments but only within a 10 mA measurement window (applies to CBA 
IV, the CBA HR has 1 mA discharge current accuracy).  A change may not be noticeable unless it is on the cusp 
of switching to the next 12 bit data level. This feature is useful to calibrate at especially low discharge rates below 
500 mA. Do not use this option without complete understanding.  For best accuracy at low discharge currents 
(below 1 amp) use a CBA HR.
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Voltage Calibrate is grayed out and only available with an Extended License (or as standard with the CBA HR).  See 
the section of the manual on Extended Software Features.
 
CBA HR makes it is possible to use laboratory grade instruments to more precisely calibrate the voltage reading 
(at a specific current level) to better compensate for lead-wire voltage drop between the test battery and CBA HR 
internal sensing circuits.  For highest precision, you may wish to use an optional 4-wire test connection harness, 
which routes the voltage sensing leads into the CBA HR via its 3.5 mm accessory connector.  When a 3.5 mm 
plug is inserted, the CBA HR changes its voltage sensing from the large Powerpole current leads, to the 3.5 mm 
accessory connector (which is then extended to the test battery terminals via optional harness).
 

 
Help
 
Contents, Index, Search:
Access to these files directly from the program instead of from the CD-ROM or our web page.
 
About CBA:
Displays the current software version running on your computer.  To determine the firmware revision within the 
CBA hardware, select Tools > CBA Devices.
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Test Configuration
 

To begin testing a battery click “File-->New” or the  button.
 
Notice that the “New Test” window defaults to the “Profile” “<Auto-Check> and is in the auto check mode. This 
profiles only needs the basic information to run a test, and the software will do the rest. Be sure to provide the 
“Test Name”, the “Battery Type” (chemistry) and provide the battery’s rated “Capacity”.
 

 
Profile
Profile defaults to “<Auto Check>” which causes the program to automatically recommend appropriate test 
discharge current and cutoff voltage from the user entered “Battery Type” and “Capacity”. It then reads battery’s 
fully charged voltage and makes a cell count estimate and recommends a test cut-off voltage and discharge 
current. This profile only requires the basic information to run a test, and the software will do the rest. Be sure to 
provide the “Test Name”, the “Battery Type” (chemistry) and provide the batteries rated “Capacity”.  
 
A user may manually override any parameter and run a test or save those custom settings as a new “Profile”. 
To add and save a new profile, use the mouse to highlight “<Auto Check>”. Then type in an appropriate name 
for a new custom profile name. The program will ask to save it as a new profile or update the information for the 
existing “<Auto Check>” information.
 
After saving a profile or profiles, recall them by typing in part of the profile name or selecting it from the drop 
down menu.
 
NOTE: If a saved profile was selected and then test parameters are changed, a prompt will ask to save those changes to the 
existing profile, or allow you to save the profile under a new name.  
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If a profile is no longer needed, highlight it and use the “Delete” button to the top right of the “New Test” window.
 
Battery Type
The “Battery Type”, drop-down selection, must be chosen correctly in order for the software to recommend how 
to test that particular type of battery.  Select the type of battery you are about to test.   
 
NOTE: If using an unusual type of battery that is not on the list, it is recommended to select Other/Custom and then 
manually set the test parameters. If unsure about any parameters - review the battery specifications or contact the battery 
manufacturer or contact West Mountain Radio.
 
Voltage
This is the rated average pack or cell voltage (average of a discharge cycle) of a battery, not the fully charged 
voltage which is actually measured by the CBA when a battery is first connected (and displayed on right-side of 
main screen).  In the “<Auto Check>” mode this is automatically calculated from the user provided battery type 
information and from the CBA’s reading of the fully charged battery voltage. 
 
Verify this voltage is correct before starting a test!  
 
NOTE: Manually changing this will also change the battery cell count.
 
Cells
This represents the number of series cells estimated to be in the pack.  Using the “Detect” button will let the 
software estimate this automatically. Verify the number of cells is correct before starting a test!  
 
Detect Button
Clicking here will fill in “Voltage” and “Cutoff V:” based on the current CBA reading. Additionally using the Battery 
Type, the number of cells will be estimated.
 
Capacity
The “Capacity” (Ah): is the rated capacity of the battery in Ah (Ampere Hours).  This must be typed in or selected 
in order for the software to recommend an appropriate discharge rate.  Normally this information is on a sticker 
on the battery, otherwise contact the manufacturer.  If the capacity is in mAh (milliampere Hours) divide by 1000 
to convert to Ah.
 
Weight
The “Weight” of the battery is optional information, not needed to run a test. It is saved with the file and is needed 
to plot a Ragone graph but only with the Extended version software upgrade.
 
Test Name
This is a required field and a test cannot be started without a test name. Be sure to choose a name which identifies 
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the battery and the current test so that it may identify the test in the future. It is suggested that, depending on the 
testing application, a naming convention be adopted. 
 
NOTE: The software automatically records battery chemistry, Ah rating and the discharge rate with every battery test. A saved 
file may contain multiple tests.  If desired, take advantage of this feature by saving files containing multiple tests within that 
file name.  Include the date and/or time in the test name to identify a test among a series of tests of the same battery.  Identify 
your batteries with unique labels tied to the test file name.
 
Test Cutoff Voltage
The program will automatically recommend the “Test Cutoff V” (voltage at which the test and discharge stops) 
that is appropriate for the chemistry selected in the “Battery Type”.
 
NOTE: 100% discharge is never 0 volts for any type of battery.  There is an industry standard for each chemistry.  Lead-Acid 
battery 1.775 volts per cell; nickel 0.9 volts per cell and lithium 2.8 volts per cell. The 100% discharge voltages may vary 
slightly between different manufacturers and may be dependent on temperature. It is recommended to verify this voltage 
from battery manufacturers’ specifications.
 
NOTE: It is possible to manually change the cutoff voltage for any reason, but do so with caution.  Do not lower the voltage 
without good reason as most batteries can be damaged due to over discharge. Lead and lithium chemistries are particularly 
susceptible to this type of damage. It is commonly believed that nickel cells actually benefit from discharge to 0 volts if they 
are then quickly re-charged. However, a pack of nickel cells should never discharged to near zero volts as a pack of cells could 
become unbalanced and damaged. The software will give a warning before starting a test if you have lowered the test cutoff 
voltage below recommendations.
 
NOTE:  Raising the Cutoff voltage will cause the load test to terminate at an earlier point, with a resulting decrease in the 
amount of energy depleted from the battery during the test.  If a battery fails to provide the energy expected, insure the Cutoff 
voltage was correctly set.
 
Test Type
Normally this would be set to Discharge.  A Discharge Test provides a regulated constant current discharge. The 
other test option featured in the standard version is Charge Monitor which uses the CBA as a recording voltmeter to 
chart voltage versus time for evaluation of a charger.  A CBA IV enables additional standard tests, one for power 
supply characterization: Power Profile and also Mission Profile.  A CBA HR enables the same tests as included with 
the CBA IV, plus adds Duty Cycle and Multiple Discharge. 
 
The Extended License allows for additional tests to become available including, Timed Discharge, Constant Resistance, 
Constant Power, Multiple Discharge, and Duty Cycle. 
 
A West Mountain Radio CBA Charger Interface board provides the ability to perform a Charge Discharge Test.
 
WARNING: Never hook the CBA to a battery that has something else connected that is not totally ground 
isolated.  To test a charger in the charge monitor mode the charger must be totally electrically isolated 
from the computer ground.
 
Sample Rate
Sets how often data is added to the graph.  Faster value will add more data to the graph, which gives more 
resolution to the test results, but results in larger test files.  Long tests, such as discharging a lead-acid battery at 
1/20 C, can use longer values as the battery voltage will not move very fast.  This is only available to users with 
Extended Software License.
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CBA Amplifiers
 
Notice the amplifier selection buttons are now available allowing use of one to four CBA Amplifiers. Be careful 
NOT to check these buttons if the test setup does not include properly connected and active amplifiers. If the test 
does include amplifiers, ensure they are connected and turned on and YOU MUST check the appropriate button 
so the software sets and records the current correctly. Amplifiers have a current gain of 10X and a power rating of 
500 watts each. The software reduces the CBA current draw to the corresponding level and records the current 
and power that would be measured at the battery terminals.
 
The “New Test” header includes the CBA serial number and name and indicates that the software is registered 
to run the Extended features enabled.
 
The CBA HR is designed for high resolution, precise current testing and cannot operate CBA Amplifiers.

Tests
 

Mission Profile (CBA IV Only)
 
This is a simplified discharge test that can be used for application specific testing. Using values from the “real-
world” application in which the battery will be used, you may test several different batteries to see which one is 
best suited. There is an option to run a test until it meets the requirements of the application (Pass) or run until 
the battery is depleted. If the battery is depleted before the minimum time is reached, the test fails - while going 
beyond the minimum time is a pass.
 
Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 
Configuration section of the Help.
 
Average Current Draw:  
The amount of current that will be drawn by the “real-world” system you are using should be entered in this 
field. The CBA will draw this amount of current from the battery until the minimum duration is met or the battery 
depleted.
 
Minimum Duration:  
How long the battery will be used in minutes.  When the time of the test reaches or surpasses this point the test 
will Pass.
 
Automatically stop when minimum duration is reached: 
Selecting this option will either end the test when the battery is depleted or after the number of minutes specified 
in the Minimum Duration field. Whichever comes first.
 

Discharge Test
 
This is a classic test for measuring and analyzing battery capacity. Using a constant current discharge, the 
battery voltage lowers until the cutoff voltage is reached and the test stops. Optionally, using a temperature 
probe, the battery temperature can be monitored and kept within safe levels. The Extended License enables 
users to not only graph temperature but also, when the temperature limit is reached, have a recovery time for the 
battery temperature to lower and allow the test to then continue.
 
Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 
Configuration section of the Help.
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Tests Amps:  
This field specifies the desired discharge rate. Using the battery specifications, enter a safe discharge rate that 
will not exceed the capability of the battery you are testing. Click the ‘Suggest’ button to have the CBA software 
make a suggestion for a typical discharge rate..
 
Graph:  
View the graphical results for a Discharge test in Amp Hours, Watt Hours, Minutes or, with an Extended License, 
Ragone. This can be changed at any time during the test or after it is completed, and also when opening a saved 
file. To do this, right click on the graph area and choose ‘Chart Properties’. Or select “Test --> Chart Properties”.
 
Graph Temperature: 
This is an Extended License feature allowing to graph the battery temperature side by side with the battery data. 
A Voltage versus Time graph is recommended for this option.
 
Recovery Time: 
This setting is enabled with an Extended License and allows the test to pause and the battery to “Recover” when 
the temperature gets above a user specified limit (as set in Tools > Preferences). After the recovery time expiries the 
test resumes until the test is stopped or the voltage cutoff is reached.
 
Capacity Check: 
This feature allows to verify  the battery capacity correlates to the manufacturer claimed battery capacity. Ensure 
the capacity window on the new test prompt matches the battery to be tested. This information is usually found 
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on a sticker on the battery. If unable to find the battery capacity, contact the battery manufacturer. The default 
Threshold is 80% and has a range of 50% to 100% of the specified capacity. Thus,  2200 mAh battery must 
supply at least 2.2 Ah * 80% = 1.76 Ah before the voltage drops below the cutoff voltage. A pass or fail result is 
indicated in the legend and the status bar. A vertical dotted line on the graph indicates the Ah required to pass.
 
Capacity Type:  
Select from Percent, Minimum Amp Hours, or Minimum Watt Hours as the pass Threshold. Using the suggest 
button will make the Threshold 80% of the battery capacity.
 

 

Timed Discharge Test
 
This test will discharge the battery until the user specified duration has expired, and then stop the test.  This 
differs from the normal Discharge test, which would discharge a battery until the cutoff voltage has been used.  A 
typical application of this test is to discharge the battery to a certain capacity, for example, a Lithium battery that 
needs to be at 30% charge before shipping.
 
Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 
Configuration section of the Help.
 

 
Test Amps: 
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This is the current, in Amps, that the CBA will draw from the battery/supply during the test.
 
Graph: 
View the graphical results for a Discharge test in Amp Hours, Watt Hours or Minutes.  This can be changed at 
any time during the test or after it is completed, and also when opening a saved file.  To do this, right-click on the 
graph area and choose ‘Chart Properties’.  Or select “Test --> Chart Properties”.
 
Duration: 
This is how long to perform the test.  Once this duration has expired the test will stop.  The test may stop 
prematurely if the voltage of the battery hits the cuttoff Voltage (see Cutoff V parameter).
 
Units: 
This specifies the length of the duration parameter, and can be either seconds, AmpHours, WattHours or percent.
 
Starting Percentage and Ending Percentage: 
If percent was used for the duration unit, then the duration field is replaced with these two fields.  The test will 
discharge the battery to the specified ending percentage based on the Ah capacity of the battery.  The starting 
percentage field is used to specify the present capacity of the battery.  For example, if the starting capacity of a 
100Ah battery is entered as 75% and the ending capacity is 10%, the test will attempt to discharge 65% of the 
battery, or 65Ah.
 
Capacity to be Discharged: 
If Percent was used for the duration unit, this field shows the final Ah value that the test will attempt to discharge 
based on the Capacity (Ah), starting percentage and ending percentage fields. The purpose of this display is to 
verify the duration, in Ah, that the test is going to perform before starting the test.
 

Charge Monitor Test
 
WARNING:  Never hook the CBA to a battery that has something else connected that is not totally ground 
isolated.  To test a charger in the charge monitor mode, the charger must be totally electrically isolated 
from the computer ground.
 
This test will use the CBA to graph voltage versus time.  Using this test, the CBA will strictly be used to monitor 
the voltage; the CBA will not draw any load from the battery.  This test is useful to monitor the voltage of a battery 
as it is being charged and can also allow the CBA to be used as a recording voltmeter for any source up to the 
CBA’s maximum voltage limit.
 
Information about the Battery section and Sample Rate can be found in the Test Configuration section of the Help.
  
Max Time: 
This field should be greater than the typical charge time for your selected battery.  In the case of using the CBA 
as a recording voltmeter, this field will determine how long the recording function will continue (up to 168 hours).
 
Graph: 
Minutes is only available graph type for this Test Type.
 
Graph Temperature: 
An Extended license will allow you to graph the temperature of your charging batterybattery, or record the 
ambient temperature during a long term recording voltmeter session.  Note this also allows the CBA to act as a 
long term (up to 168 hour) recording temperature instrument, with a 1 second sample rate.
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Power Profile (CBA IV and CBA HR Only)
 
This test is extremely useful for characterizing different power supplies, solar cells and batteries. The voltage 
current relationship is extremely useful and the data gathered will allow your power supply to operate at optimum 
power output and efficiency. This test continuously increases the load by the Current Increment while the voltage 
is graphed versus current or versus power. Using a voltage versus power graph, the peak power output of a 
battery or power supply can be accurately measured.  In similar manner, this test may be used to investigate the 
maximum power point (MPP) of a solar panel.
 
Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 
Configuration section of the Help.
 

 
Current Increment: 
The test begins with a load of zero amps and increases the load on the battery or power supply at a rate specified 
in Hold Time until the Cutoff Voltage or the Cutoff Current is reached; or the CBA becomes Current Limited 
(because the 150 Watt max power rating has been reached). If the CBA is Current Limited in a Power Profile 
test, the test will end.
 
Cutoff Current: 
Using the battery specifications, enter a Cutoff Current that will not exceed the limitations of the battery being 
tested.  When the load becomes greater than this value the test will end. For example a current increment of 
1.5 and a cutoff current of 12 will graph 9 points (test begins at zero amps) if the Voltage does not fall below the 
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cutoff.
 
Graph: 
Data for this test type can be displayed in Voltage versus Amps or Watts. By graphing in Watts, the maximum 
power output is represented by the right most data point.  Data can also be displayed in Watts versus Amps.
 
Hold Time:
This specifies how long, in seconds, the current will be maintained until the software reads the voltage and 
increment the current to the next step.

 

Duty Cycle (Extended Software)
 
The duty cycle test is particularly valuable when attempting to evaluate the performance of a battery in an 
application which typically involves a cyclic or variable duty cycle. This test is much more exact and repeatable 
than manually pausing a test or starting and stopping multiple tests.  Duty Cycle test is included with the CBA 
HR to help simulate battery usage in small remote devices which wake up occasionally to report (transmit) their 
status, followed by a prolonged sleep period.
 
Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 
Configuration section of the Help.
 

 



24West Mountain Radio Operating Manual

Load Type:
This field selects the type of CBA load presented to the battery being tested.  The CBA can simulate 3 different 
load types – Current, Resistance, or Power.  Selection of the load type results in the box below it changing 
accordingly, allowing the user to program the actual load to be maintained in constant Amps, Ohms, or Watts.
 
Current - Operating as a Current load type, the test battery will be depleted during the CBA’s “on” time period 
using a constant current (Amps) load, as determined by the value set in the “Current” box.  In this mode, the 
CBA effectively lowers its internal load resistance as the test battery voltage falls, thus maintaining the discharge 
current at a constant amp level throughout the test.
Resistance – Operating as a Resistance load type, the test battery will be depleted during the CBA’s “on” time 
period using a constant resistance (Ohms) load, as determined by the value set in the “Resistance” box.  In this 
mode, the CBA maintains a constant ohmic value load on the test battery, thus allowing the discharge current to 
decrease proportionally as the test battery voltage falls during the test (per ohms law).
 
 
Power – Operating as a Power load type, the test battery will be depleted during the CBA’s “on” time period 
using a constant power (Watts) load, as determined by the value set in the “Power” box.  In this mode, the CBA 
varies its internal resistance to maintain a constant wattage load on the test battery, thus compensating for the 
decreasing test battery voltage as the test proceeds (per ohms law, where Power = Voltage x Current).
 
Period On: 
This is the number of seconds the battery will be discharged at the given rate.  Valid settings range from 5 to 
9999 seconds.
 
Period Off: 
The load current will drop to zero amps during this off-time period and will continue at zero load for the number 
of seconds specified here. Valid settings range from 5 to 9999 seconds.  The duty cycle will be  Pon  / (Pon + 
Poff).  This discharge test will continue to cycle in this On/Off time pattern until the test battery voltage falls below 
the value programmed in the “Cutoff V” box.
 
Graph: 
A Duty Cycle test may be viewed graphically in Amp Hours, Watt Hours or Minutes. This can be changed at any 
time during the test or after it is completed, and also when opening a saved file. To do this, right click on the graph 
area and choose ‘Chart Properties’. Or select “Test --> Chart Properties”.
 
NOTE: When graphing in AmHrs or WattHrs the cycle may not be apparent and therefore it is suggested to 
display in Minutes.
 

 

Constant Power (Extended Software)
 
You may also run a test with constant power instead of constant current. With this test mode the load current will 
be constantly increased as the battery voltage decreases over time. Useful for batteries that are used in systems 
which require consistent power.
 
Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 
Configuration section of the Help.
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Watts: 
Use this field to specify desired load discharge Power in Watts. Using the manufacturer’s battery specifications, 
enter a safe value that will not exceed the ratings of the battery testing. Also note, the CBA without amplifiers has 
a power limitation of 150Wand CBA HR is limited to 10W.
 
Graph: 
Graphical results for a Constant Power test may be viewed in Amp Hours, Watt Hours or Minutes. This can be 
changed at any time during the test or after it is completed, and also when opening a saved file. To do this, right 
click on the graph area and choose ‘Chart Properties’. Or select “Test > Chart Properties”.
 
 

Multiple Discharge (Extended Software and CBA HR)
 
Battery applications that experience a variety of different current loads, such as a variable number of running 
motors, can be simulated using this Multiple Discharge test. This test allows realistic and real-time analysis of 
performance under highly variable load conditions. When entering the load conditions, use the manufacturer’s 
battery specifications to enter a safe discharge rate that will not exceed the ratings of the battery being tested.
 
Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 
Configuration section of the Help.
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Steps:
The number of set point load conditions that will be sequentially executed.  Valid entries are 1 to 99999 
steps.  Manually programming such a large number of steps is impractical, but below is described a method to 
capture and import actual field data, which can then be used to simulate complicated real-world load conditions. 
 
Units:
Selectable for Amps or Watts for the set point battery load for each step.  This option is only available on the CBA 
IV.  The CBA II, III and CBA HR can only use Amps as the set point value for each step.
 
Loop Until Depleted:
If this is unchecked, the test will terminate upon completion of the last set point setup.  For example, if the 
number of Steps is set to “3”, the test will finish after the third step is completed.  
 
If checked, upon completion the last set point, the test sequence will loop back to the first set point and repeat 
the sequence of steps.  For example, if the number of Steps is set to “3”, upon completion of the third step, the 
sequence will return to step one and continue.  The test will always terminate, regardless of this setting, if the 
voltage read by the CBA is below the Cutoff Voltage.
 
Steps:
For each step, the current (in Amps) or power (in Watts) and the time duration of the step (in seconds) must be 
programmed.  Once that step’s duration has expired, the test will proceed to the next step.
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Graph:
View graphical results for a Multiple Discharge test in Amp Hours, Watt Hours or Minutes. This can be changed 
at any time during the test or after completion, and also when opening a saved file. To do this right click on the 
graph area and choose ‘Chart Properties’. Or select “Test --> Chart Properties”.
 
Import:
Automatically populates all the step set points and duration times by importing a CSV text file containing power 
usage data.  Tip:  The West Mountain Radio PWRcheck may be used to measure and capture real-world load 
conditions.
 

Importing Step Value
Importing reads a text CSV file where each line represents a new step for the Multiple Discharge test.  The CSV 
file can either be created by the West Mountain Radio PWRcheck software (with the PWRcheck tool capturing 
actual field load data), or by manually creating/editing a CSV text file with a text editor.  An example CSV file is 
provided in the same directory as the CBA software, with the filename import_example.csv.
 
The format of each row, or line, in the CSV file is as follows:

number, time, voltage, current
 
number is the line number, and is ignored during the importing. 
time is the timestamp of this set point, and has the format H:MM:SS. 
voltage is the voltage at this set point, in Volts. 
current is the current of this set point, in Amps.
 
Here is an example line (at a time of 30s, 13.8 volts and 8.5 amps):

0,00:00:30,13.8,8.5
 
The first line of the CSV is ignored.
 

 
Filename:
This is the filename and path to the CSV file that is to be imported.
 
Setpoint rate:
This is the sample rate at which to read set points from the CSV file. A longer duration here will reduce the 
number of steps imported into the test parameters. Due to hardware limitations, the CBA and the software will 
not allow a step duration that is faster than the hardware can achieve. See the Sampling section below for more 
information about how this value is used.
 
Sampling:
When importing steps from the CSV, the software will not create set point durations faster than the set point rate 
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specified by the user (see previous section). If ‘skip’ was used for the sampling method, entries in the CSV that 
occur faster than the set point rate will be skipped until the next set point rate duration has expired. If an ‘average’ 
choice was used for the sampling method, the software will average power for entries in the CSV that occur 
faster than the set point. The ‘average’ option simply averages all the skipped set points in the CSV, whereas the 
‘weighted average’ option gives emphasis to skipped set points with longer durations.
 
Units:
Configures whether the CSV importing should import Amps or Watts from the CSV for the step set point values.

 

 

Constant Resistance (Extended Software)
 
This test simulates a constant resistance (ohmic) load on a battery. In this test the load is specified in ohms.  The 
actual battery discharge current (amps) during the test is represented by the battery voltage at that moment in 
time divided by the set point resistance. So as the battery voltage decreases during the test, the current will also 
decrease.  

(Per ohms law:  Current=Voltage/Resistance)
 
Information about the Battery section, Amplifier section, Cutoff Voltage and Sample can be found in the Test 
Configuration section of the Help.
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Resistance: 
This field specifies the desired load Resistance in Ohms. Using the manufacturer’s battery specifications, enter 
a safe value that will not exceed the capability of the battery being tested.
 
Graph: 
Graphical results for a Constant Resistance test may be viewed in Amp Hours, Watt Hours or Minutes. This can 
be changed at any time during the test or after it is completed, and also when opening a saved file. To do this, 
right click on the graph area and choose ‘Chart Properties’. Or select “Test --> Chart Properties”.
 

 

Charge / Discharge Test 
(CBA IV Only When a Charge Controller is Connected)
 
WARNING:  Never hook the CBA to a battery that has something else connected that is not totally ground 
isolated.  To operate a charger in the Charge/Discharge test mode, the charger must be totally electrically 
isolated from the computer ground.
 
This test can be performed by selecting ‘Charge Discharge’ as your Test Type.  This option will not be valid 
unless the West Mountain Radio CBA Charge Controller is connected to the PC via a USB cable.  Verify this by 
looking for this device in Windows Device Manager, under the section labeled ‘Custom USB Devices’.  For more 
details see CBA Charge Controller.
 
Information about the Battery section, Amplifier section, Cutoff Voltage and Sample Rate can be found in the Test 
Configuration section of the Help.
 
 
The test alternates between charge and discharge cycles.  Discharging is accomplished with a West Mountain 
Radio CBA IV.  Charging is accomplished by having a West Mountain Radio CBA Charge Controller or an off-the-
shelf charging. When using Charge/Discharge test mode the software will disable the “Test Name” field.  Instead 
the software will create test names ‘Charge n’ and ‘Discharge n’ automatically (where n is the cycle number, and 
increments automatically).
 
The settings for the Charge/Discharge test are split into two tabs of the Window:  Basic Settings tab and Advanced 
Settings tab.  When a Charge/Discharge test is run, the software will use the settings from both tabs.
 
Test Amps: 
During a discharge cycle, this is the load current the CBA will draw from the battery under test. Using the 
manufacturer’s battery specifications, enter a safe discharge rate that will not exceed the capability of the battery 
you are testing.
 
Maximum V: 
During a charge cycle, if the read voltage goes above this value the CBA software will stop the charge cycle.  This 
should only be used as a fallback, instead the CBA Charge Controller unit should be looking at the IN-A and IN-B 
signals to determine when the charge cycle is complete.  IN-A and IN-B should be connected to some kind of 
indication on the battery charger, like an expansion port or charge complete LED.  The software will populate this 
field on a value that is 0.5V greater than the estimated charge/float voltage based on this battery’s chemistry type 
and number of cells.  Since this is 0.5V greater than the charge/float voltage, this value is generally at a level that 
would not damage the battery.
 
Graph:  
Graphical results for a Charge Discharge test may be viewed in Amp Hours, Watt Hours or Minutes. This can be 
changed at any time during the test or after it is completed, and also when opening a saved file. To do this, right 
click on the graph area and choose ‘Chart Properties’. Or select “Test --> Chart Properties”..



30West Mountain Radio Operating Manual

 
Graph Current: 
If checked, the CBA software will also graph current (as a separate plot) during the charge cycle.
 
Cycles: 
This specifies how many cycles to perform.  A cycle is either a charge or a discharge.  Performing both charge 
and discharge would be 2 cycles.
 
First: 
This specifies what cycle should be performed first, a charge or discharge.
 
Charger: 
If there are multiple CBA Charge Controllers connected to the PC at once, this pull-down can be used to specify 
which Charge Controller to use for this test.
 
Recovery after discharge: 
After a discharge cycle is complete, this is how long the software will wait before moving on to the charge cycle.
 
Recovery after charge: 
After a charge cycle is complete, this is how long the software will wait before moving on to the discharge cycle.
 
Ignore charge after cycle complete:
When starting a charge cycle, the software will ignore the IN-A and IN-B inputs until this time has expired.  This 
is useful if the charger has an LED that has a slight delay before toggling when it starts its charging cycle.
 
Stop charge cycle after #.### AmpHrs:
When performing a charge cycle, the software will stop the charge cycle and move on to the discharge cycle once 
it has measured the specified AmpHours going into the battery.  This is measured using the current detection 
circuit inside the CBA Charge Controller.
 
Stop charge cycle below #.### Amps:
When performing a charge cycle, the software will stop the charge cycle once the current going into the battery 
has gone over this value and then back under this value.  The purpose of this parameter is to provide another 
method of stopping the charge cycle without needing to connect to the IN-A or IN-B of the CBA Charge Controller, 
since it can be assumed that if the current goes below this value, that means the charger has finished charging 
the battery.
 
Graph voltage on charge cycle:
If selected, the voltage of the battery will be graphed during the charge cycle as it is being charged.
 
Stop charge cycle after #.### seconds
If selected, the software will switch from charge cycle to discharge cycle once this duration has expired, regardless 
of any other stop conditions (such as Stop Voltage, IN-A, IN-B, etc.)
 
Stop discharge cycle after #.### seconds
If selected, the software will switch from discharge cycle to charge cycle once this duration has expired, regardless 
of any other stop conditions (such as cutoff voltage).



31West Mountain Radio Operating Manual

 

Test Example
 

Testing a Battery:
The following example will lead you through testing a 3 cell (3S, 11.1 volt) lithium polymer battery.
 

 

1. After starting the program click the  button or to go “File-->New.”   
Notice that the Profile is set to the default “<Auto-Check>” selection. Leave it set to this for and use the 
“<Auto-Check>” to help test this battery.

2. Select “Li-Poly” in “Battery Type” for this example is testing a lithium polymer battery.  
3. Plug in the battery using the CBA’s Powerpole test connectors. Be careful to make a solid connection 

with the correct polarity. 
 
Notice, when plugging in the battery the CBA panel on the right-side of the test window now shows the 
voltage. At this time either click the “Detect” button or correctly fill in all the necessary fields. Using the 
“Detect” button will change the “Cells” to 3 and the nominal “Voltage” to 11.1 (average voltage for a 
three cell Li-Poly pack). The program will also set the “Test Cutoff V”. Make sure that this is all correct.

4. Type in or scroll to the rated capacity for the battery; in this case 2.2 Ah. The sticker reads 2200 
mAh Capacity. This is converted to Ah by dividing  by 1000. Again the program can automatically 
recommend the discharge rate by clicking the “Suggest” button. The program will suggest settings for a 
one hour discharge for most battery types.

5. Enter the Weight of the battery; if interested in a Ragone graph, which adds weight as a variable in the 
graph.

6. Enter a meaningful test name that may include which battery being tested, the date, the cycle 
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information or other useful information.
7. The CBA standard software version has selections of “Discharge” (A constant current 
discharge which is the most common way to evaluate battery capacity) and “Charge 
Monitor” which monitors the battery voltage as you charge it. Make sure the Graph Type is 
set to “Discharge”. 
 
NOTE: It is optional to change the discharge rate, “Test Amps” or cutoff Voltage, however the 
program will “ask you if you are sure”, if choosing a higher discharge rate or a lower cutoff voltage, 
before allowing the test to begin.
8. Make sure all information displayed in the New Test Box area is correct.  If necessary, fix 
the entries before starting the test.
9. Press the “Start” button at the bottom of the test box and start the test. 
 
NOTE: Selecting OK will close the test box and display the graph, allowing to check or change 

advanced variables. Then start the test by selecting  in the main menu.
 
 

This shows an example of the readings displayed while testing a single cell Lithium at 22 
amps.  Note the readings displayed, the virtual fan is running, and virtual LEDs are lit like 
the LEDs on the CBA are lit.

 
The example is near the start of a test and the “Voltage” is at 3.80 V at 22 amps.  Note 
the “Current” is not exactly at 22 amps, but 22.04: this is normal. The current will fluctuate 

perhaps 1% as the CBA is constantly adjusting.
 
The “AmpHr” will steadily increase as the discharge continues and the power in “Watts” will decrease as the 
battery voltage drops.  If a temperature probe is connected, that reading would be shown here also.
 
The test will stop when one of the specified limits is reached:  
 > the voltage of the battery dropping to the pre-set “Test Cutoff V” 
> the optional temperature probe sensing that the user set over-temperature limit  
   has been reached 
> or if operating at the limits of the hardware (150 watts or 40 amps) the CBA itself 
   overheats due to lack of cooling or high room ambient temperature. 
 
 
 
 
 
WARNING: Never run a test unattended!  Even though we have included many safety features unexpected 
things could happen that could cause a battery explosion or fire.  Also certain types of computer lock 
ups could cause the CBA to over discharge the battery.
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Graph of the Completed Test:
 

 
Test Data: 
During the test all variables are displayed.
 
Voltage:  
Initial voltage (was 12.6 volts, end voltage was 8.4 volts)
 
Amp Hr: 
The rated capacity of this battery is 2.2 Ah and the test measured 2.347 Ah. This is a 1 hour (1C discharge).   Most 
lithium batteries are rated at 2 hour (0.5C discharge).  Even at this higher rate the capacity of this battery is better 
than its ratings.
 
Test Complete
 
After completing this test there are several options for starting another test.

•	 Save this file by selecting “File --> Save” or “Save As” and name and save the file in the default My 
Documents/CBA directory, or the directory of choice.

•	 Select “Test --> New” and the program will prompt if to append a new test on the previous test or start a 
new test document.  If a similar battery is to be compared, then select append, otherwise select a new 
test after saving.
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Saving and Printing
 
Saving:
After a test completes go to “File --> Save” or click . The name in the “Test Name” box will be suggested as 
the default name, or edit and pick a different file name.  It is important to choose a name that identifies what test, 
or tests are contained in the saved file.
 
Note: Changing the file name will not change the test name of the graphs on the screen.
 
The first time saving a file, a window requesting confirmation of the file name and directory will appear.
 

Subsequent saves (“File --> Save” or click ) will save the file, but will not ask again for file name or directory.
 

 
 
When closing the program, or the test that is on the screen, a prompt will ask if would like to save that test, or 
tests, to a file.
 
If attempting to start another test with a test on the screen the program will give the following choices:
 

 > Selecting “New Test” will prompt for a test to be appended or to 
start a new graph.
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NOTE: If desiring to save multiple tests in the same file they MUST be of the same “Test Type” (Discharge, Constant Power). 
If attempting to overlay a new test, the test type will be grayed out.
 
NOTE: If opening a previously saved file, with previous test/tests in it, more tests may be added to it.  With the “File --> 
Overlay” menu choice, open additional test files and those graphs will automatically be overlaid over the test graphs that are 
already on the screen.  When trying to save an overlay screen with multiple test files on it, a prompt will be asked if wanting 
to overwrite (erase) the last file opened and replace it. Be careful to choose the correct option.
 
Printing Test Graphs:
Since the CBA is able to save a file with multiple overlay graphs, provided is the option to print in either color or 
black and white.  For Black & White printing, there are unique tick marks on each graph to identify each graph 
trace with a corresponding legend key.  For color printing each graph has its own color.  Be sure to select Black 
& White when printing on a non-color printer.  
 

1. Go to “Tools --> Preferences” and select Black & White if wanting each graph plot uniquely identified 
with a Black & White legend keys.  

2. Go to “File --> Print Setup” and select desired the printer.  Normally select portrait mode for the print 
out.

3. Select “Tools --> Preferences” and then select “print charts in black and white”.   
 

4. See print preview below for an example of the tick marks (different marks identify different graph traces 
on black and white printers).   
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5. Go to “File --> Print”.  Select number of copies as well as another opportunity to select the printer. 
 

 
 
Optionally to go to “File --> Print Preview” window to see how it will look before printing.  If it is OK, press 
“Print” at the top of the preview window.  If it is not OK, close that window and go back to correct the 
printer setup.

 
Printing Battery Labels:
A convenient method to save test information is to place it directly onto the battery.  The CBA software includes a 
label printing utility designed to produce self-adhesive battery labels which include an identification and summary 
of the test data. Begin by selecting “Print Labels” from the file menu.  The dialog box allows to select specific 
tests and preview the layout, which are designed to use standard address labels.
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Select the file names from the directory list with the tests that a label is needed, or use the “Select All” button for 
all files and tests.
 

 
Use the print preview to see the labels that will print and in the correct location on the sheet.  The program will 
print a label for each test in each file no matter how many each file contains.
 
Note: File names are being selected and files may have multiple tests in them.  One label will be printed for each test in the 
selected files.
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Licensing
 
To purchase an Extended license follow the instructions on West Mountain Radio.  License information will be sent 
by email. NOTE: This information is case sensitive.
 
After receiving the information start the program and connect the CBA that matches the License information. 
Click on the connected icon at the bottom right, or go to “Tools > CBA Devices”.
 

 
 
 
 
 

 
 
 
 
Select the connected CBA that the license is valid for and click “License.”
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Enter your registration information exactly as shown in the email “Licensee:”, “CBA serial #:” and the “License 
Key:”. Optionally enter a “CBA Name:”, which is suggested if planning to use multiple CBAs in the future. 
 
Clicking “Identify” will flash the selected CBA’s green LED for a few seconds - which is useful when running a 
large group of CBAs on one computer. The default name contains the serial number preceded by “CBA #”. It is 
good practice  to choose a unique name to identify this particular CBA to distinguish from others that may be in 
a larger group running on one computer.
 
If prompted to do so, close the program after registering the license and then restart the CBA software.
 

 

Extended Software Features
 
This section covers the advanced features available only with an Extended License. These features will be grayed 
out unless a License is purchased and registered.  Be sure to enter the name the license should be registered 
under, CBA serial number and license key in the “Tools > CBA Devices” window.
 
It is recommended to be familiar with the standard operation of the CBA before learning about and using the 
Extended features. The “New Test” window will have several additional features.
 
Note:  If running multiple CBA’s on one computer, it is an option to have Extended Software running on some, 
or all of them.  Since the software is tied to only one CBA serial number, an individual Extended license must be 
purchased for each CBA that needs to use extended features.
 
Once the Extended License is registered, the software will show“(Extended)” on the “New Test” screen along 
with the CBA name chosen.
 

 
New Test Types:
Extended software includes all features included with the standard version and adds several new test types: Timed 
Discharge, Duty Cycle Test, Constant Power, Multiple Discharge, and Constant Resistance.  The CBA HR (high resolution) 
software package already includes Duty Cycle and Multiple Discharge tests, as standard.
 
Sample Rate:
The rate at which data is added to the graph can be adjusted.  A fast sample rate can be used to spot fast acting 
events that may have been missed at slower sample rates.  A slow sample rate will save less data, resulting in 
smaller test files.  The default sample rate is typically set to 1 second.
 
Voltage Calibrate:
This calibration feature accounts for resistance in the leads between the battery terminals and the Powerpole® 
connector on the CBA. Each CBA has its own stored Voltage, Current and Temperature calibration, therefore if 
using multiple CBA units, it is easy to designate each one with a specific calibration set-up. If the CBA does not 
seem to be reading correctly, check these settings first. If an accurate voltage measurement is needed, use the 
following instructions for the voltage calibration procedure.
 
NOTE: For maximum accuracy and safety always use very secure, very low resistance connections.
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Calibration Procedure:
1. Put a high accuracy voltmeter across the point desired to read calibrated voltage, perhaps across a cell for single cell 

testing or at the connector supplied with a battery pack.
2. Start a test at the intended current for the battery to test and with the wiring intended to be used for testing.
3. Record the voltage that the software reads “V_CBA:”
4. Record the voltage that the voltmeter reads “V_Battery:” at the calibration point. 
5. Record the average “Current” “I:” shown by the software while the voltages are being measured.
6. Stop the test and go to “Tools --> Lab Calibrate --> Voltage Calibrate”. 

 

7. In the calibrate voltage window, click “Reset” to clear any previous calibration and then enter readings that have 
been recorded. 

8. Press “Calculate” and the calculated resistance will be valid for all future tests with this CBA and test harness 
assembly until it is reset. The voltage readings graphed and displayed will be corrected accordingly. 

9. Press “OK” to save the calibration settings for future tests with this CBA and harness setup.  Note -  If the test setup 
is changed, the recalibration should be performed again, or the custom calibration should be “reset” back to zero 
factory conditions.

 
Graph Notes: 
Text notes may be added directly onto a graph and associated with a specific graphical line or data point. They 
may be color keyed and positioned anywhere on the page.  Notes are helpful to identify different tests and 
important observations within an individual test.  They are especially useful when complex graphs are overlaid. 

 
 
This test below is a graph of a duty cycle test using Voltage versus Time. The test was set for 30 seconds on and 
30 seconds off at a 4 amp load.
 
Move the cursor to the graph until you see the test name displayed.  Position the cursor directly onto a specific 
data point, then right click and select “Add Note”.
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The note properties screen allows for typing the text to be displayed, as well as the location and distance (px) to 
where the text will be placed, relative to the line data point you selected.
 
Set the pixels in the “px” box and the direction of offset with the “Location” check boxes.
 
Font style, color, and size may be edited with selections to the left.
 

 
The final note is shown on the graph and may be edited or deleted by right-clicking on the body of the note.
 
Temperature Graphing:
If using the optional temperature probe and Extended Software, select “Graph Temperature” for most (but not all) test types. 
This will overlay a second graph on each test screen with the temperature. A temperature probe must be connected to the 
CBA and calibrated with the sensor in intimate contact with the center of the battery for proper readings.
 
The test will be stopped when the temperature is above the specified threshold or a “Recovery Time” (Discharge 
Test) can be specified. When the battery reaches the threshold temperature, the test will stop for the given 
recovery time and then resume. To see the results over time for battery temperature cool down and voltage 
recovery, use a Voltage versus minutes graph, not Amphrs or Watthrs.
 
Ragone “Graph” type (Extended Software):
An additional graph type is available with the Extended Software that will compare radically different type and 
size batteries on the basis of power density (power to weight). This graphing type is particularly useful when 
selecting a battery to power a device that is weight sensitive, such as small electric vehicles and mobile devices.
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Note: This Ragone graph can only be displayed if a test was started and saved with the correct weight of the tested battery in 
the new test window.
 
For additional information on Ragone plotting see http://en.wikipedia.org/wiki/Ragone_plot.

 

CBA Charger Interface
 
Charge / Discharge Test
 
The West Mountain Radio Charge Controller has the following inputs and outputs:

•	 IN-A and IN-B:  These should connect to a signal on the charging unit that indicates charging is 
complete.  An LED will suffice.  These inputs can handle up to 12V.

•	 OUT-A and OUT-B:  These outputs are shorted (relays closed) when the software is starting a charge 
cycle.  The purpose of this is to connect to a push-button on a charging unit, where the push-button 
might control the start/stop of the charger.

•	 Powerpole® Connectors:  When a Charge/Discharge test is not running, or during the Discharge cycle 
of a Charge/Discharge test, these Powerpoles® will be open.  During a Charge cycle, these Powerpoles® 
will close (short) and the West Mountain Radio Charge controller and the CBA Software can read the 
current drawn by the battery from the charger unit.

•	 Green LED:  LED is lit when the CBA software has connected to the West Mountain Radio Charging 
Interface board.  
NOTE: There is a green power LED also.

•	 Yellow LED:  LED is lit when the CBA software is currently performing a Charge/Discharge test.  The 
Yellow LED will turn off when test is complete.

•	 Red LED:  LED is lit when the CBA software is currently in a charging phase of a Charge/Discharge 
test (the Powerpoles® are closed and the charging unit is connected to the battery).

 
When starting a charging cycle, the CBA software will close both the OUT-A and OUT-B relays and leave them 
closed for the duration of the cycle.  If this is not compatible with the charging unit or more flexible options are 
needed, contact West Mountain Radio to assist in supporting a particular charging unit.
 
While performing a charging cycle, the CBA software will look for a signal high on either IN-A or IN-B to signify 
a charge complete.  If this is not compatible with the charging unit or more flexible options are needed, contact 
West Mountain Radio to assist in supporting a particular charging unit.
 
Typical Setup
The CBA and battery are both connected in parallel to the indicated Powerpole® connector. When the test is 
in Discharge, the relay on the Charge Controller is open and creates an open circuit. Similarly, during charge 
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mode, the CBA acts as an open circuit while the Charge Controller relay is closed and the battery is charged. 
The following is a setup diagram:
 

 

Multi CBA/CBA HR Configuration
 
This section explains how to configure a multiple CBA testing setup. Standard CBA software (included with all 
new units) provides support for multiple CBAs on one PC, quantity limited only by the PC’s processing power, 
memory and number of internal USB ports.  CBA III models are limited to 12 units per PC.  Any number of CBA 
IV and CBA HR units may be used together in the Standard or Extended Software.
 
An Extended License is still required for specialized testing options, as documented elsewhere in this manual.  Since 
Extended software is tied to the CBA’s serial number, an Extended licensee is required for EACH CBA that needs 
those specialized testing features. To purchase an Extended License visit West Mountain Radio.
 
Licensing Requirements

•	 Multiple CBA III setups require a Multi CBA License (12 max units)
•	 Multiple CBA IV setups DO NOT require any additional licenses
•	 Multiple CBA HR setups DO NOT require any additional licenses
•	 Any mixture of CBA Basic and Extended software can run on a multi PC setup with multiple CBA IV’s and 

CBA HR’s (where the Extended features only apply to that individual CBA with specific matching serial 
number).

 
Computer system requirements

•	 CBA III, CBA IV, and CBA HR only (CBA and CBA II not supported)
•	 Desktop computer (laptop computers not supported)
•	 Minimum of a 400 watt PC power supply
•	 Available PCI slots for additional USB connections (1 PCI slot per 4 CBAs)
•	 Pentium 2 GHz or better
•	 Running other applications not recommended when in use
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•	 Internal USB ports (root hub) required  - NOTE: External hubs will not work
 
It is recommended the computer be dedicated for testing batteries.  Do not expect to run other applications while 
testing batteries.  Do not connect or disconnect USB devices while testing batteries.  Disable screen saves and 
sleep modes to prevent loss of computer control during a test.
 

Multi CBA Operation Only
This section is specific to Multi CBA operation only.  Refer to the rest of this help documentation for complete 
instructions to operate each CBA.
 
Connection and Installation:
Plug multiple CBAs directly into the USB ports of a desktop computer.   
NOTE: If using a laptop computer, all power saving features must be turned off.
 
If using more CBAs than available USB ports, it is suggested to add an internal USB PCI bus cards that may be 
purchased at West Mountain Radio.  
 
WARNING:  It is not recommended to use or expect an external USB hub to work.
 
The internal USB PCI bus cards should be installed in the PC like any PCI card. To install the driver files, connect 
to the Internet so that Windows plug & play system will automatically install the drivers from Windows Update.  If 
the PC does not have access to the internet, use the driver installation files from the CD ROM provided.
 
Each PCI card has four ports available at the back of the card slot. It does not matter which CBA is plugged into 
which port on which USB card or PC USB ports, but it is recommended that CBAs are all either plugged directly 
into the computer, or into the PCI cards; not a combination of both.
 
Before installing a Multi CBA system, ensure that installation is complete.  Run through a stand-alone system 
test with one CBA. Read the manual and help file completely to be familiar with the operation of using one CBA 
before trying a multi CBA system.
 
Go to “Help --> About CBA” and verify having CBA software version 2.1.0.14 or later.  If an earlier version is 
detected, visit the download page and download and install the latest version update.
 
Setup
If more than one CBA is connected without a valid Multi-CBA license or CBA IV connected, the program will not 
start.  Licensing and new hardware can be obtained from West Mountain Radio (No Multi-CBA License is required 
for CBA IV and/or CBA HR). For further instructions on license entry see Licensing.
 
NOTE: Do not unplug the USB cables with the program running.
 
Testing Multiple Batteries:
It is important to carefully identify all tests with multiple CBAs.  The software specifically requires a test name for 
each test.  By default it uses that name for the file name when saving the completed test file.  However, file name 
may be changed when saving the test.
 
One way to keep track of tests is by using a unique number for each battery. If testing the same batteries over 
and over, consider including the cycle number as part of the test name.  Consider including the date or time as 
part of the name so that it will be visible on a graph when viewed at a later date. This version of the software 
does allow putting notes on a graph with date and time, or for including that information part of the test name. 
 
To start a new test from a blank screen, click the “New Test document” icon below “File”.  This will bring up a 
small window asking which CBA to use. If unable to distinguish between the different CBAs, select one and click 



45West Mountain Radio Operating Manual

“Identify” - which wil blink its green LED.  Choose the desired CBA and a “New Test” window will appear along 
with a tabbed blank graph window behind it.  Connect the battery, and select a test profile or correctly fill in the 
parameters and start the test.
 
Continue until all of the batteries are being tested or all the CBAs are in use.  In a given time, the first test will 
complete and the corresponding tabbed graph will pop-up over the others.  A completed test window will pop-up 
and the software will “beep” the PC speaker until the test has been saved and discharged battery disconnected
 
NOTE: Notice the test graph tabs come up in the order the next test was selected.  To re-arrange the order, click on the tab 
with the left mouse button, hold it down, and drag the tab over to a new location.
 
When a test is completed on a CBA, another battery test may be started while the other CBAs are 
running.  Disconnect the battery and click “Test --> New”.  A prompt will appear asking if it should append the 
graph or start a new one.  Only tests of the same type can be appended to the current graph. Connect the next 
battery and type in the test info and start the test. Do this procedure in order as indicated for best results.
 
NOTE: When in the process of connecting another battery and starting a new test when a test, it is possible that a different 
test reaches completion and displays another pop-up completion notice which switches to its completed graph tab.  If this 
happens, simply close the new completed test notice window and finish starting the new test. 
 

 

Testing From Script
 
This section explains how to configure your CBA software to run tests from a command line or scripting language. 
If using multiple CBAs, first ensure that connecting to multiple CBAs is allowed while the program is operating.  If 
using a CBA IV, this capability is built in.  If unsure, start the CBA software and select ‘Tools’ and then ‘CBA 
Devices’.  
 

 
Begin by plugging in the CBAs and if more than one shows up (similar to what is pictured above), please read 
the help section Multi CBA.
 
Returning to the scripting language or command line, it is very important that all commands are carefully reviewed 
before they are run. 
 
NOTE: These command line parameters are for expert users.    USE EXTREME CAUTION and please review the Safety 
section of this help manual.
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CBA Software Command-Line Options:
Items in italics are dynamic, value to be specified by user.
 
Command Parameters Comments

/test

*discharge   amps
*power          watts
*resistance  ohms
*multiple       loop,n,t1,a1,...,tn,an
*duty             amps,ton,toff
*profile          increment,
                       cutoffcurrent
*chargedischarge
                      first,cycles,
                      amps,highVoltage

Initiate a hands-free test.  
A hands-free test will open the software to 
perform a test, and when the test is complete 
the software will automatically close.
 
The software will return the following result 
codes when test is complete:
  0 = test run completely
 -1 = invalid or missing parameters
 -2 = could not find CBA
 -3 = parameters are valid, but the power 
        requirements would damage CBA.
 
Reduce desired test current or reduce test 
voltage.
-4 = test stopped because internal temperature  
       too high
-5 = test stopped because temperature probe  
       too high
-100 = Critical error, contact West Mountain 
Radio
-101 = Critical error, contact West Mountain 
Radio
 

 
 
*This parameter should be given before other parameters:*
 
The following command-line options are required to use /test:
     /cutoff
 
discharge performs a Discharge Test with constant current draw from the battery.  
    amps specifies the desired current.
        Example (1.5 Amp Test, cutoff at 10.5V):
        /test discharge 1.5 /cutoff 10.5
 
power performs a Constant Power Test with constant power draw from the battery.
    watts specifies the desired power draw.
        Example (50 Watt test, cutoff at 10.5V): 
       /test power 50 /cutoff 10.5
 
resistance performs a Constant Resistance Test with constant resistance load on the battery.  
    ohms specifies the desired load.
        Example (5 Ohm test, cutoff at 10.5V): 
       /test resistance 5 /cutoff 10.5
 
multiple performs a Multiple Discharge Test with multiple set points of constant current draw. Loop is optional.  If the 
word loop appears before the other parameters, then the software will loop to the first test point at the completion 
of the last point.  If the word loop does not appear before the other parameters, the software will finish the test 
when the last test point is complete.  
n specifies the number of constant current set points.  
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tn specifies the duration, in seconds, to draw this current.  
an specifies the desired current draw for this set point.  
 
Test will complete prematurely if the cutoff voltage is hit (to stop this affect, set cutoff voltage to 0).
 
Be aware that CBA Amplifiers draw a small offset current even when ‘Disabled’.
 
When using multiple discharge set points, if there is a set point with 0 load current, there may still be a small 
offset current if using a CBA Amplifier.

 
Example no loop (10A for 30 seconds, 30A for 5 seconds, 0A for 20 seconds, 5A for 120 seconds, then 
test stops):
/test multiple 4,30,10,5,30,20,0,120,5 /cutoff 10.5
Example with loop (10A for 30 seconds, 30A for 5 seconds, 0A for 20 seconds, 5A for 120 seconds, then 
loop to first profile point):
/test multiple loop,4,30,10,5,30,20,0,120,5 /cutoff 10.5

 
duty performs a Duty Cycle Test at specified amps load current, load is applied for ton seconds, and not applied for 
toff seconds.  ton and toff cannot be fractional numbers.  Test is automatically stopped when voltage drops below 
cutoff voltage.
 
profile performs a Power Profile Test with load beginning at zero and increasing every 8 seconds by the specified 
increment until the cutoff current value is reached or the battery voltage falls below the /cutoff parameter.
        Example (2A increment with 20 A cutoff current and 8.5V cutoff)
        /test profile 2,20 /cutoff 8.5
 
charge-discharge performs a Charge Discharge Test that will cycle between charge and discharge cycles until 
completed. First is used to indicate if the test will begin with a charge cycle or discharge cycle. The cycles 
parameter indicates the number of cycles to complete. A cycle is either a charge or a discharge, so two cycles 
will result in both a charge cycle and a discharge cycle. The desired load is specified with amps. The highVoltage 
parameter provides a limit to the battery voltage during charging.
 
The following command-line options can also be used with /test:

/battery, /cutoff (Required), /open, /title, /temperature, /graph, /amplifiers, /unit, /chargeunit, /chargegraph, 
/graphcurrent, /chargeignore, /chargerecover, /chargeamphrlimit
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Command Parameters Comments

/battery

capacity,
cells,
voltage,
weight,
type

When performing a hands-free test with /test and saving results to 
a file with /open, this command sets the battery information.  This 
is only used for informational purposes and does not affect the test 
parameters.  If this is not specified, random data may be saved to 
the file.
 
Type is battery type, and the following strings are allowed:

•	 Alkaline
•	 Carbon-Zinc
•	 Lead Acid (LiFePO4)
•	 Li-ion
•	 Li-poly
•	 NiCd
•	 NiMH
•	 Other

 
Example (4Ah, 6 Cell 13.2V battery, 5.5 pounds):
/battery 4,6,13.2,5.5,”Lead Acid”
 

/cutoff voltage

Specify the cutoff voltage.  If using a hands-free test, this parameter 
is required, if not specified the program will not run a test.  The 
test is completed when the battery goes below this voltage 
   
Example: 
/test discharge 1.5 /cutoff 10.5

/open filename

Specify which test results file to open. If a hands-free test mode 
was initiated with /test command-line option, then test results are 
saved to this file when finished.
 
Example: 
/open test.bt2

/title title

When using /test for hands-free test and saving results to a file 
specified by /open, this option sets the title of this set of data when 
appending to the file.  This parameter is optional.  If user does not 
specify a title, software will use “TEST”.  If title is already used 
in specified file, test name will be appended with an incremental 
number (ex. “TEST 2” will become “TEST 3”).
 
Example:
/test discharge 1 /open test.bt2 /title “Test XRF200”

/temperature n

n specifies the temperature in Celsius to stop the test, to prevent 
test from running if external temperature is too high.
 
All tests support stopping at the specified temperature (n) however, 
not all tests support temperature graphing. Temperature will be 
graphed if the selected test supports it and saved to file (/open) 

/temperatureF n

n specifies the temperature in Fahrenheit to stop the test, to prevent 
test from running if external temperature is too high.
 
All tests support stopping at the specified temperature (n) however, 
not all tests support temperature graphing. Temperature will be 
graphed if the selected test supports it and saved to file (/open).
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/graph

AmpHrs
WattHrs
Minutes
Ragone
Amps
Watts

If performing a hands-free test (/test), this specifies the graphing 
format to be used.  Ragone graphing only works for discharge 
tests. Amps and Watts are only available for PowerProfile tests

/amplifiers n For a hands-free test, specifies the number of CBA Amplifiers 
connected to the system.  If this is not specified, it is assumed 0.

/unit Serial

For multiple CBA operation, this is an optional argument to specify 
which CBA to use.
Example: 
/unit 40100

/chargeunit Serial

For multiple Charger Interfaces this is an optional argument to 
specify which Charger Interface to use 
  
Example: 
/chargeunit 45999

/chargegraph  

For Charge Discharge Test: If specified, will graph Voltage during 
charge portion of test 
  
Example: 
/chargegraph

/graphcurrent  

For Charge Discharge Test: If specified, will graph Current during 
charge portion of test. 
This will be ignored without “/chargegraph” 
  
Example: 
/chargegraph /graphcurrent

/chargeignore time

For Charge Discharge Test: Delay time in seconds to ignore input 
signals on Charger Interface. DEFAULT: 0 seconds 
  
Example: 
/chargeignore 20

/chargerecovery time For Charge Discharge Test: Delay time in seconds between 
charge and discharge portions of test. DEFAULT: 60 seconds

/chargeamphrlimit AmpHrs

For Charge Discharge Test: During charging phase this 
parameter will stop the cycle after the specified number of 
AmpHrs. 
  
Example: 
/chargeamphrlimit 2.800

/dischargerecovery time

For Charge Discharge Test:  when discharge cycle is complete, 
this is how long the software will wait before moving onto the 
charge cycle.  The time parameter is in seconds.
 
Example: 
/dischargerecovery 20

/graphvoltage  

For Charge Discharge Test:  if this parameter is used, then the 
software will graph voltage during the charge cycle.
 
Example: 
/graphvoltage
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/chargeampmin Amps

For Charge Discharge Test:  if this parameter is used, then the 
charge cycle will be considered complete if the current going into 
the battery goes over Amps and then below Amps.
 
Example (200MA minimum current: 
/chargeampmin 0.2

/samplerate time

Sets the sample rate, the rate at which data is added to the 
graph.  This requires an extended software license.  The time 
parameter is in milliseconds.  Not all time values are valid, use 
the software in non-handsfree mode to verify valid values for your 
hardware.
 
Example (250ms sample rate: 
/samplerate 250

 
 
Hands Free Testing
An external software program, or script, can initiate a hands-free test by executing the software with the /test 
command-line options.
 
        For example:
    “C:\Program Files\CBA III\WMRCBA2.exe” /test discharge 2 /cutoff 10.5 /open 
   result.bt2
 
The software will remain open and run the test until the test has completed.  For most tests, it is completed 
when battery voltage has dropped below cutoff voltage.  For multiple-discharge test, test will complete after the 
specified duration has expired -or- the cutoff voltage is reached, which ever happens first.
 
When the test is complete, the software will close and return an error code to the external software program or 
script.
 
A batch file is present in the executable directory that shows a working of example of calling the .EXE and 
handling the returning error level.

 

Temperature Probe
 
Temperature Graphing (Extended Software Version)
If an Extended License and the Temperature Probe accessory have been purchased, the option of graphing an external 
temperature and stop a test if an external temperature hits a user-specified threshold is available. Simply click the ‘Graph 
Temperature’ radio button when setting up a Discharge Test. If running a standard Discharge Test, there is also “Recovery 
Time” check box and time box. Recovery time allows a load test which has been completed to continue for additional time 
to record any overshoot in the battery’s temperature rise. It will also allow a running test which has paused due to over 
temperature (as set in Tools > Preferences) to continue after cooling.
 
CBA IV - Plug the temperature probe two-pin flat connector into the right most pins (closest to the LEDs) of the 
available pins in the cover slot. It does NOT make any difference which way it goes in as long as it is plugged in 
to the far right two pins.  The extra pins are for future options. 
 
NOTE:   If using this software with a CBA II, do not remove the blue jumper.  CBA III and CBA IV do not have this jumper.
 
For CBA HR, the optional temperature probe is connected via a 3.5 mm accessory jack located near the 
Powerpole connectors.  Be advised - when a 3.5 mm plug is inserted, you MUST also implement 4-wire remote 
voltage sensing.  This is required since the 3.5 mm input serves two purposes - temperature and remote voltage 
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input.  When the plug is inserted, the CBA HR’s internal voltage sensing (normally connected internally to the 
Powerpole connectors) is disconnected and routed out via the 3.5 mm plug.  Thus using a temperature probe 
ALSO requires use of a remote 4-wire type battery load sensing connection harness.  See CBA HR Auxiliary 
Inputs  (Joey – link to this section, below)
 
Calibration - Allow the probe sit in a location away from any heat source for enough time to acclimate to room 
temperature.  Have a good thermometer nearby, to determine an accurate temperature reading.  For laboratory 
quality measurements, consider calibrating near the temperature of interest by submersing both the probe a high 
accuracy thermometer in the water warmed to near the temperature expected during your test.
 
With a temperature probe connected to the CBA, go to “Tools”, “Lab Calibrate”, “Calibrate Temperature Probe” 
and enter the accurate reference temperature reading in either degrees C, or F, the reference temperature 
reading and click OK to save that calibration.  This will serve to “teach” the CBA software to associate the exact 
temperature with the resistance reading of the thermistor in the probe.
Note: Temperature Probe should not need to be recalibrated as long as the same CBA unit is being used.
 

 
To use the probe, attach it in close physical contact with the center of the battery, or battery pack being tested.  Hold 
it in place with the probe’s magnet (most round cells are magnetic), or with tape or a rubber band (for better 
contact and more accurate readings thermal compound may be used).    Be certain it stays in close contact with 
the battery during the test. The CBA temperature readings are quite accurate over the range that a battery may 
be operated, however readings will be incorrect if the probe is not in close contact with the battery or there is 
air moving over it. Unlike an instant response IR thermometer, other types of thermometers take a considerable 
amount of time to display their temperature reading. There is a noticeable thermal lag with our thermistor type 
probe.
 
The CBA may be set for automatic over temperature cutoff.  Place the probe on the battery.  Go to 
“Tools”,  “Preferences” and check the check box next to “Stop test when battery reaches ? deg”.  Fill in a 
temperature appropriate for the battery (60 degrees C or less should be safe for most batteries).
 
WARNING: DO NOT continue a test if the “Temp:” indication reaches or exceeds the maximum temperature 
specification for the battery being tested.

 

CBA HR Auxiliary Inputs
 
CBA HR Auxiliary Connector
The CBA HR contains a 3.5 mm auxiliary connector jack, positioned just to the left of the large Powerpole test 
connectors.  There are two remote circuit functions associated with this connector, thus the connector jack 
serves two purposes. 
 
It can be used with optional 4-wire measurement harness, which provides enhanced battery test voltage sensing 
by moving the CBA HR’s voltage sensing function from the large Powerpole (current) connectors, to an isolated 
measurement circuit (via 3.5 mm plug) to minimize test-lead resistance voltage drop. 
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A second circuit within the 3.5 mm plug serves as the remote input for optional magnetic temperature probe 
(requires Extended Software license). 
 
Note - Since the CBA HR automatically switches its battery test voltage measurement from Powerpole 
to 3.5 mm connector whenever a 3.5 mm plug is inserted into the auxiliary input, the use of an 
optional temperature probe ALSO requires the use of remote voltage sensing wire lead harness.  
   

   
  

 

Firmware Updates
 
Some CBA devices have the capability to be updated with new firmware. 
 
Update Procedure:

1. Open the list of CBA devices by selecting ‘Tools’ and then ‘CBA Devices’ from the menu. 
2. Select the CBA you wish to update, and if this CBA device has the capability to be updated the ‘Update’ 

button will be available.
3. Clicking ‘Update’ will prompt the ‘Update CBA Firmware’ window. This window provides the selection 

to choose which firmware to update using the pull-down labeled ‘File’. Pressing the ‘Update’ button will 
cause the firmware to be sent to the CBA.

 
The ‘Device’ and ‘Status’ section of the window will show a status during the update process. After new firmware 
is sent to the device, the ‘Status’ section will say ‘Success’ when the CBA is ready to be used again.
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WARNING: DO NOT unplug the CBA IV during a firmware update.
 

 
The CBA update is complete.

 

Serial Port
 
Interconnection
The CBA has a 5 pin accessory port where PIN1 closest to the LEDs.
The CBA HR does not have a serial port.  Sections covering RS-232 signal pin-outs and AT Command 
programming language do not apply to CBA HR.
 
In order to use this accessory port with a serial interface, disconnect the USB and power the CBA through the 
accessory port. 5V power should be able to source at least 200 mA. The serial interface is 3.3V TTL and 5V 
tolerant. The Baud Rate is 2400.
 
PIN1 GND
PIN2 Reserved
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PIN3 POWER
PIN4 Tx
PIN5 Rx
 
NOTE – CBA pins 1 & 2 are used for optional Temperature Probe input.  Review that section for additional details 
on temperature sensor connections.
 
The following is a schematic to convert computers RS-232 signal to communicate with the CBA.
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Commands
 
WARNING: It is very important that all commands are carefully reviewed before they are run. This interface is for 
expert users.  USE EXTREME CAUTION and please review the Safety section of this help manual.
 
Use the following AT commands to interface your application with the CBA.

 
Function Command Parameters Description
Read AT*VER Version Firmware version  

AT*VER?

Write AT*TEST

TEST_UA,  
TEST_UV,  
TEST_UA,  
TEST_UV  
     
or  
     
0

Specify in microAmps and microVolts.  
Values are entered twice to ensure proper settings 
and error detection.  
     
Stop current test  
AT*TEST=0  
Load=1.25 Amps, VoltageCutoff=4.5 Volts  
AT*TEST=1250000,4500000,1250000,4500000  
 

Read AT*STATUS

SECONDS,  
READ_UV,  
TEMP,  
TEST_UA,  
TEST_UV,  
PLIM,  
STOP_REASON,  
CS

Returns the status of the current or completed test. 
Voltage in microvolts and Current in microamps. 
PLIM is 1 when test is Power Limited 
STOP_REASON       [1]Running, 
                               [2]Low Voltage, 
                               [3]Over Temperature, 
                               [4]Other (likely user stop)
 
TEST_UA, TEST_UV and SECONDS will retain their 
previous value until a new test starts. 
AT*STATUS? 

Notify *STATUS

SECONDS,  
READ_UV,  
TEMP,  
TEST_UA,  
TEST_UV,  
PLIM,  
STOP_REASON,  
CS

Response to AT*STATUS? or Automatically sent 
by the CBA every interval seconds specified in 
AT*SEND 
CS - Check Sum - sum all digits and add number of 
digits (not commas) then modulus 256 
*STATUS=95,5056604,9999,0,0,0,1,94
 
To calculate Check Sum:
Sum digits = 77 + 17 digits = 94 % 256 = 94

Notify *STOP
STOP_REASON,  
SECONDS,  
0

STOP_REASON listed as text. “OTHER”, “VOLTAGE”, 
“TEMP” 
SECONDS at Test Stop

Write AT*SEND INTERVAL

INTERVAL in 100’s of ms, at which the *STATUS 
message is automatically sent. 
AT*SEND=50  Status update every 5.0 seconds. 
AT*SEND=0     No status updates

Read AT*SEND INTERVAL
INTERVAL in 100’s of ms, at which the *STATUS 
message is automatically sent. 
AT*SEND?

Write ATE0 none Echo Off (default)
Write ATE1 none Echo on
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Example Program
 
(hidden) ATE1                               //Turn echo on to see as you type
 
AT*SEND=50                                     //Set status updates for every 5 seconds
 
AT*SEND?                                          //Get Current Interval
AT*SEND=50                                    //Confirmed status update interval
 
//Set test for Load=1.25 Amps, Voltage Cutoff=4.5 Volts
//Values in microvolts and microamps
 
AT*TEST=1250000,4500000,1250000,4500000
 
*STATUS=5,11462368,9999,1250000,4500000,0,1,118
*STATUS=10,11463655,9999,1250000,4500000,0,1,116
 
//A while later
 
*STATUS=1200,4529254,9999,1250000,4500000,0,1,122
*STOP=VOLTAGE, 1201, 0
 
//Test Stopped Because of low voltage at 20:01 minutes (1201) seconds
//Status Messages Continue
 
*STATUS=1200,4496851,9999,1250000,4500000,0,2,133  
*STATUS=1200,4487823,9999,1250000,4500000,0,2,132
AT*SEND=0              //Turn off Status updates
AT*STATUS?             //Get Status Manually
AT*STATUS=1200,4491300,9999,1250000,4500000,0,2,117
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Troubleshooting
 
No CBA units available
If the CBA program indicates “No CBA units available” when opening a new test window; and/or the CBA green 
LED or virtual LEDs are not on when a CBA is connected and the program is running - the Windows® CBA USB 
driver installation may not have been properly completed.  Re-boot the computer. Plug the CBA back in. Repeat 
our hardware installation instructions and try it again.
 
If it still does not work, open Device Manager:

•	 In Windows 7, this can be done by opening Control Panel, selecting ‘System and Maintenance’, selecting 
‘System’ and then selecting ‘Device Manager’.

•	 In Windows 10, this can be done by opening Control Panel, selecting “System”, selecting Device Manager.
•	 From the device manager, scroll down to “Universal Serial Bus Controllers” and expand + that list.  If the 

CBA is not located, try looking in the section labeled ‘Other Devices’.  When the CBA is located, right click 
on it and select ‘Remove Device’. Then disconnect and reconnect the CBA back into the PC.  If the CBA 
software persists on not recognizing the CBA hardware, contact West Mountain Radio support.

 
CBA Charger Interface is not connecting
Make sure the CBA is software running and try reconnecting the USB cable to the Charge Controller.
 
CBA does not indicate voltage
The battery may not be connected or it is completely dead. 
  OR
CBA unit may be damaged.  Contact West Mountain Radio support.
OR
CBA HR may have a 3.5 mm plug inserted into its auxiliary port, thus disconnecting internal voltage sensing from 
the Powerpole battery test connectors.
 
CBA gets too hot and shuts itself off
The CBA has an internal temperature monitor that is programmed to protect it from overheating when operated 
at maximum ratings and at normal room temperature.
 
Make sure the fan is running during a test, nothing is blocking the cooling inlet, and the CBA is being operated in 
a relatively cool location.  Do not use it in direct sunlight or on near a heat source, such as too near the battery 
being tested.
 
Do not attempt to conduct successive high current tests without letting the CBA cool down and shut off its fan 
between tests.
 
Some CBA Menu selections are grayed out and do not work  
These are typically the optional features available only with the Extended Software License.  Visit www.
westmountainradio.com to purchase an Extended License.
 
No load drawn from CBA during test, or test runs but battery voltage never decreases
The usual cause for this is the internal safety fuse in the CBA has blown. If this is suspected, remove the red lid 
from the bottom of the CBA and check the automotive style ATOATC fuse connected to the PCB (25A for CBA; 
2A for CBA HR).  Verify this fuse is okay and replace if necessary.  If running high power CBA IV tests, it might be 
necessary to replace the factory installed 25A fuse with the 40A fuse, as separately, packed with each new CBA 
IV,  If the fuse is okay but the CBA is still not drawing power, contact West Mountain Radio support.
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Computer System Requirements
 
Basic Requirements:

•	 A PC with a Pentium 233 or better
•	 At least an 800 X 600 graphics card and display monitor
•	 Windows 98SE, ME, NT, 2000, XP, Vista, Windows 7 (32 or 64 bit), Windows 8, Windows 10
•	 An available USB port

 
Recommended:

•	 AMD or Pentium,1.2 GHz better.
•	 Better than 800 X 600 graphics card and display monitor.
•	 Windows XP, Vista or Windows 7, Windows 8, Windows 10
•	 1 GB or more RAM
•	 An available USB port

 
For graph and label printing:

•	 Any Windows compatible, laser or ink jet, color or black and white, printer
•	 Avery 5160 (laser) or Avery 8160 (Inkjet) labels are required for label printing

 

Support
 
If you cannot find the answer to a question about using the CBA here in this manual and help files, you may get 
help several other ways.
 
Web Support:                 http://www.westmountainradio.com/support
Email:                              support@westmountainradio.com
Phone:                             262-522-6503 x32
Fax:                                  262-522-6504
Mail:                                 West Mountain Radio
                                         1020 Spring City Drive
                                         Waukesha, WI 53186
 
For problems with the computer or USB port, contact the computer manufacturer.
 
For problems with the Windows operating system, contact the computer manufacturer if Windows came pre-
installed or Microsoft directly.
 
For problems with a battery or a product being used with it, contact that manufacturer or supplier.
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CBA IV Warranty
CBA IV is warranted against failure due to defects in workmanship or 
materials for one year after the date of purchase from West Mountain 
Radio. Warranty does not cover damage caused by abuse, accident, 
misuse, improper or abnormal usage, failure to follow instructions, 
improper installation, alteration, lightning, or other incidence of excessive 
voltage or current. If failure occurs within this period, return the CBA IV 
or accessory to West Mountain Radio at your shipping expense. The 
device or accessory will be repaired or replaced, at our option, without 
charge, and returned to you at our shipping expense. Repaired or 
replaced items are warranted for the remainder of the original warranty 
period. You will be charged for repair or replacement of the CBA IV or 
accessory made after the expiration of the warranty period.
West Mountain Radio shall have no liability or responsibility to customer 
or any other person or entity with respect to any liability, loss, or damage 
caused directly or indirectly by use or performance of the products or 
arising out of any breach of this warranty, including, but not limited to, 
any damages resulting from inconvenience, loss of time, data, property, 
revenue, or profit, or any indirect, special incidental, or consequential 
damages, even if West Mountain Radio has been advised of such damages.
Except as provided herein, West Mountain Radio makes no express 
warranties and any implied warranties, including fitness for a particular 
purpose, are limited in duration to the stated duration provided herein.

                                                        www.westmountainradio.com
                                                    1020 Spring City Drive, Waukesha, WI 53186      
                                                              tel 262-522-6503 fax 262-522-6504


